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Welcome to the latest edition of my monthly Final Cut Studio newsletter for October, 2008.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are archived at the end of each 
year with key articles posted on my website for your reference. All software references are 
to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find daily 
tips, latest industry news, over 350 articles, and tutorials to help you get the most out of 
Final Cut!
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WRAP-UP

WELCOME

My gosh, these are not easy times! I'm stunned, watching what's happening in the stock market. I talk with 
editors on a daily basis who describe clients and jobs vanishing overnight. My heart goes out to everyone 
who is suffering from all this - which, at this point, seems to be just about all of us. Things are a mess.

But, rather than sit in a corner and sulk, I've decided to cram in as many interesting tips and techniques as 
I can this month - to give you something fun to look over and think about.

As always, I'm grateful for all your email and conversations - working with folks like you makes my life fun. 
Thanks!

NEW PRODUCT REVIEW -- DROBO 

Storage, as you know, is essential to video 
editing. Even better is expandable storage. And 
the ideal is expandable, flexible storage. And with 
that, cue the music, enter Drobo.

Drobo is a product of Data Robotics. Recently, 
Mark Fuccio, Senior Director of Products and 
Markets, asked me if I'd like to review a unit. 
Since I love reviewing new toys, I immediately 
said yes and shortly thereafter, a Drobo 
appeared on my doorstep.

It arrived in two boxes - each about a cubic foot 
in size. The first box held the Drobo and the 
second box held the drives. Unpacking was a 
breeze - I especially like the fact that the Drobo 
came wrapped in a cloth bag, rather than plastic. 
I also liked the overall humor and friendliness in 
the packaging and instructions. 

There are two cables that need to connect to the back of the unit - a power cable and a FireWire 800 
cable. The cables are a bit tricky to put in, and I'd like a cable lock to help prevent the power cable from 
detaching, but hooking this up is not difficult. 

Drobo is not like any other hard disk or RAID I've ever worked with before. It holds up to four standard-
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issue hard drives, which can be purchased from any vendor, including Drobo. Unlike other RAIDs, 
however, the drives don't have to be the same size, same speed, or even from the same vendor. In my 
test unit, I was given drive sizes of 40, 250, 250, 750, and 1000 GB. (I'll explain the purpose of the fifth 
drive in a minute.)

What makes Drobo different from other storage is that it always stores your media in a protected state 
(like a RAID), but unlike a RAID, you can expand your system by adding more, or larger, hard drives at 
any time. Drobo reconfigures itself and re-protects your data automatically. This expandability means that 
you can start with just two medium-sized drives and add more storage as your needs increase. This is 
something that can not be done without reformatting in a traditional RAID.

Note: Protected means that your data is copied to at least two drives. That way, if one drive 
fails, your data can be restored from the other drive. Most RAIDs provide protected storage 
(RAID 0 does not). However, Drobo can provide protected storage without using traditional 
RAID technology. 

For my test, I installed four drives: 40, 250, 250, and 750 GB. There's no RAID that I know of that allows 
you to mix drive sizes this way. (It was also a delight not having to use a screw driver or socket wrench to 
install them. They just slid in and locked.)

This combination of hard drives gave me a total of 496 GB in protected storage. (The "Reserved for 
expansion" category is storage that I could access if I replaced my small 40 GB drive with something 
bigger.) 



Drobo has gone through two generations so far: the first was a USB-connected device, and the second is 
a FireWire 800 unit. My unit used a second generation FireWire 800 connection. (Data Robotics also 
makes the DroboShare, a unit which attaches to your network via Ethernet. While very useful for general 
file storage and backups, this is too slow for video editing and I decided not to test it.)

Installing from the included CD is simple. I was surprised at how fast it formatted the disks - it was ready 
to accept data in less than two minutes. During the installation it asked if I wanted to use the Drobo with 
Time Machine. Since Time Machine only backs up the boot drive, I said no.

Drobo has a software utility, called "Dashboard," that allows you to manage the unit. After trying 
unsuccessfully to install Dashboard as a widget, I realized it was a stand-alone application and placed it in 
my Applications folder. Sigh... 

During our conversation, Mark suggested I take a look at how the Drobo could be useful in video editing. 
So my first test looked at whether it would be fast enough to act as primary storage; that is, as the main 
media drive, for editing. 

And the short answer is: not really. 

Any drive is fastest when it is empty. So, with the drives totally empty, I used a current version of 
Blackmagic Design's Disk Speed Test to learn that Drobo's average disk read speed is 22.6 MB per 
second and its average write speed is 25.3 MB per second. While fast enough for DV and HDV, this is 
comparable to a slow, single FireWire 400 hard drive.

Note #1: The Drobo web site shows an average write speed of 34 MB/second and an 
average read speed of up to 55 MB/second. Using this test, I was not able to achieve those 
speeds. 

Note #2: Visible on the front panel are ten lights that indicate how full the drive is. However, 
hidden under the front cover are activity lights that show when a transfer is taking place. If 
you want to see how hard your unit is working, simply remove the magnetically attached 
front cover. 

I then decided to see how long a data transfer would take. So I copied 120 GB of data (composed of a 
series of large R3D HD files) from an internal RAID on my MacPro to the Drobo. It took 1 hour and 27 
minutes -- roughly equal to a transfer rate of 24 MB per second.

http://www.blackmagic-design.com/


After the drive had all this additional data on it, I decided to replace the 40 GB drive with a 750 GB one (i.
e. instant storage expansion) and watch it rebuild my data. So, I yanked out the 40 and slapped in a new 
750. Naturally, I didn't bother to turn off the power -- just to see what happens. 

It was great. Drobo took the new drive, added it to the system, and reconfigured my storage from 496 GB 
to 1.3 TB. it took less than 30 seconds for the unit to reconfigure itself with the new drive.

Here's the Best Part - the Second Test 

While the Drobo is too slow to be the main storage for many video formats, such as Digibeta, DVCPRO-
HD, ProRes, or anything uncompressed, its expandability and data protection make it ideal for use in 
acquiring tapeless media. Whether you are shooting P2, SxS, or other tapeless video formats, all of them 
are MUCH slower than the Drobo. This makes the Drobo very attractive in a production environment - it 
instantly stores your data in a protected format, is fully expandable, its physical size makes portability 
easy, and it is more than fast enough to do the job.

As the video world rapidly goes tapeless, the Drobo has a significant role to play in video production and 
capture. Best of all, its price makes it very attractive.

An empty Drobo, ready to take drives, retails for $499. Since drives can be purchased anywhere, in any 
size, prices for a fully-loaded Drobo will vary. Buying a 4 TB unit from Data Robotics costs $1,099 (US) 
retail.

Drobo is a lot of very slick technology packaged in a very attractive box. If low-cost, expandability, and 
data security are more important to you than speed, you need to look closely at Drobo.

http://www.drobo.com/Products/Index.html

UPDATE - Oct. 11

Mark Spencer asked: 
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Very nice review on the Drobo, but I do have one question. If the Drobo is too slow for 
DVCPRO-HD, but it's fast enough for P2 - there's a problem, because P2 IS DVCPRO-HD! 
Or am I misunderstanding you?

Larry replies: Good point.

What I was saying is that for editing (which requires multiple video streams), its too slow. For transferring 
media from a tapeless source (which is a single video stream with the ability to vary data transfer rates as 
necesary), its really nice. I mean, for some things you could edit from it. But that's leading to a weakness. 
Its strength is that is an expandable system providing protected storage for your media. 

[ Go to Top. ] 

LAST CHANCE FOR  
LARRY'S POWERUP WITH FINAL CUT PRO SEMINARS 

I know the economy is in the tank and all of us are scrambling to find and keep clients. On the other hand, 
change in our industry is a constant and what you don't know can often make the difference between 
success and failure.

I've designed this year's seminars to provide answers that are not covered in any Apple-Certified course 
on Final Cut Pro. In fact, much of this is not even easy to find on the Internet. 

In other words, there's a lot of value to you in attending my seminar -- and there are only a few cities left. 

Here's where we will be in October:

�●     New York City -- Oct. 14 & 15 
�●     Boston -- Oct. 17 & 18 
�●     Charlotte, NC -- Oct. 20 & 21 
�●     Miami -- Oct. 23 & 24 
�●     Chicago -- Oct. 27 & 28 
�●     Vancouver, BC -- Oct. 30 & 31 
�●     Los Angeles -- Nov. 7 & 8 

Important Note: Due to schedule conflicts, I only have time next year to visit 5 or 6 cities -- 
I'll select the most popular cities from this year's tour. This means that I will not be able to 
return to many of this year's cities after this trip. Please register today before it's too late!

This year, we've created three new seminars:

Seminar 1:  
Succeeding in the New World of Tapeless and HD Video

Manufacturers and distribution are moving to HD and 
tapeless as fast as they can pull the tape drives out of new 
cameras. But this new workflow requires us to have a much 
different technical understanding of how this stuff works. This 
4-hour seminar answers key questions like:

�●     What is the right HD format for my work?
�●     What gear do I need to move to HD?
�●     Where does ProRes fit in?
�●     How can I get better organized?
�●     How do I trouble-shoot my system?
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Seminar 2:  
Watch How Adobe CS4 Production Premium 
Can Help a Final Cut Studio Workflow 

Every editor I've ever met uses Photoshop, but did 
you know PhotoShop does video editing, too? DVD Studio Pro does not 
support Blu-ray Discs, but Encore does. Final Cut Server can help you locate 
files, but so can Bridge, for a fraction of the cost and much better than you 
might think! 

This 4-hour seminar shows you how to:

�●     Create automatic text transcripts in Soundbooth 
�●     Clean-up video images in Photoshop
�●     Easily move files between Final Cut Pro and After Effects
�●     Create better Flash videos
�●     Test your videos on hundreds of mobile devices
�●     Discover the benefits of using OnLocation on set 

Seminar 3:  
Discover the Hidden Power in Final Cut Studio

The number one request from our seminars last 
year was "show me more...". So this 8-hour 
seminar show you how:

�●     To repair poor audio
�●     To do better audio mixing
�●     To create and monitor surround sound 
�●     To customize royalty-free music 
�●     To automate compression for DVDs 
�●     To create a Blu-ray Disc 
�●     To create Flash videos
�●     To transcode HD to SD

In other words, if you want to improve the sound of your projects, or the look 
of your finished video, this seminar is for you.

Economically, I realize that times are tough. However, I've designed my seminars 
to save you time and money with every job, plus show you techniques that will 
blow your competitors out of the water. I can help you avoid wasting money and 
time. 

My tour is over in less than three weeks. You don't have any time to waste.  
Sign up today -- I don't want you to say "I shoulda gone..."

Click here for more information.

Click here for a list of cities.

Click here to register. Sign up today to reserve your seat! 

Thanks to our sponsors! 

I am very grateful for the support of our sponsors. Putting on a tour of this magnitude takes 
a lot of hard work and money. This would not be possible without the generous support of 
our platinum sponsor: Adobe Systems; our gold level sponsors: Blackmagic Design, 
Media Distributors, and The Rental Station, and our silver level sponsors: Automatic 
Duck, and SmartSound.
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Note: Media Distributors is running a raffle, giving away free seats to our seminars. If you haven't already signed up - do so here: 
www.mediadistributors.com.
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TECHNIQUE: BLURRING THE EDGES OF A CLIP 

One of my readers suggested I write about this technique and I apologize for not writing down the name of 
the person that suggested it.

Here's the problem. You want to blur an image, except that the clip is less than 100% in scale. When you 
add a blur, the image gets blurry, but not the edges. What do you do?

Normally, Final Cut processes all filters before applying any motion effects. This is generally a good idea 
and doesn't cause any problems. However, sometimes you need to have it do the motion effect first, then 
the filter. The only way we can do that is to create a nest.

A nest is a clip, or group of clips, that have been converted to a sequence. The advantage to nesting is 
that we can apply an effect to a nest that affects all the clips inside the nest.

Here's how to do it.

1. Edit your clip into the Timeline, then double-click it to load it into the Viewer.

http://www.mediadistributors.com/


2. Select the Motion tab and change the scale to any number smaller than 100. In this case, 
I'm working with a 50% scale (half-size).

3. Select the clip in Timeline (this can also be a group of clips in the Timeline) and choose 
Sequence > Nest Items. In the resulting dialog, give the nest a name. (Here I'm using "My 
Blurry Clip.") What the nest does is turn the clip into its own sequence. And, just as we can 
apply effects to a clip, we can also apply effects to the sequence.

4. Select the sequence and apply Effects > Video Filters > Blur > Gaussian Blur. The 
filter is now applied to all the clips in the sequence. Normally, to load a clip into the Viewer 
for adjustment you would double-click it. However, that doesn't work for a sequence. If you 
double-click a sequence, it opens for editing. In order to load it into the Viewer, you 
OPTION-double-click it.

5. In the Filters tab, set the Radius setting to 30 (or any other number you prefer). 30 is a 
large amount of blur, which makes the effect very obvious.



Ta-DAH! A blurry image with a blurry edge!

You can use nests in lots of different ways. For me, I use them whenever I need to apply a single effect to 
a number of clips (for example rotating a group of clips around a central axis) or when I need to change 
the order so that motion effects are processed before filter effects.

Cool.

Note: While this technique works with images that are scaled, it doesn't work with images 
that are cropped. If you want to apply, say, a border to a cropped image, you'll need to use 
two layers: the top layer is the foreground, cropped to the dimensions you need, and the 
bottom layer is the border color, cropped to be slightly bigger than the foreground. 

The picture below illustrates this.



UPDATE - Oct. 11 

George Mauro has a different way to do this same effect:

Here's what I do.

Take a clip; we'll say 720 x 480 to make it simple. Place it into a sequence of the same 
size; Call it 'Mary'. Now CMD+0 to open the sequence settings and change the sequence 
size to say 1440 x 960. The black around the clip is larger, hence the bigger stage size, but 
the original clip is still 720 x 480.

Now nest Mary into another 720 x 480 sequence, 'Jerry' and add the blur filter or the wave 
or ripple..what ever. Notice, by Option+DoubleClicking nest into the viewer that the scale of 
Mary is now 50%. Make it 100% and no clipping of the filter occurs. 

Larry replies: George, I'll have to work this through a bit. Still, its a cool work-around. I don't often mess 
with changing the size of the sequence. 
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DIGITAL PRODUCTION BUZZ HAS A BIRTHDAY! 

Only four years ago, there were no podcasts anywhere on the planet. That changed in late 
2005 with the arrival of DV Guys. Hosted by Ron Margolis, the show focused on making 
technology accessible. Along the way, the show transitioned from Ron to Philip Hodgetts 
and became Digital Production BuZZ. Still later in its life, I took it over.

The BuZZ is one of the longest running podcasts still in weekly production and we 

http://www.digitalproductionbuzz.com/


celebrate our 200th Anniversary podcast this Thursday, October 16.

I'll be in Boston, presenting at the Boston Final Cut Pro User Group (BosFCPug), then hosting my part of 
the show in front of a live audience. I'm delighted to be joined by Dan Berube, founder of BosFCPug, as 
our east coast co-host.

Back in our LA studios, Cirina Catania (producer of The BuZZ) will be joined by Mike Horton (Head-
cutter of the LAFCPUG) and Philip Hodgetts (CEO, Intelligent Assistance) along with a host of fans, 
friends, and interesting guests.

If you haven't yet tuned in to The BuZZ - take a few minutes to check us out. Our goal, since the 
beginning, is to make the technology of video production, post-production, and distribution accessible to 
all of us. 

I welcome your comments, questions, and suggestions. Click here to learn more! 

By the way, click here to learn more about BosFCPug! www.bosfcpug.org
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DIGITAL PRODUCTION BUZZ IS THE  
OFFICIAL PODCAST FOR DV EXPO AND GOVERNMENT EXPO!

The folks at NewBay Media have asked us to be the Official Media Partner of DV Expo - Nov. 4-6 at the 
Los Angeles Convention Center.

 

DV EXPO 

Get behind the camera at this year’s DV Expo. Our camera-focused sessions include 
technical information and training on the industry’s hottest cameras including a day-long 
Digital Cinematography Supersession and training on the RED ONE, Sony EX3 and 
Panasonic AG-HMC150 cameras.

More than 45 conference sessions and top industry exhibits showcasing hundreds of new 
products await you and your questions. These three days will be packed with education and 
information you won't get anywhere else! DV Expo is the MUST ATTEND EVENT of the 
year!

No sooner did we say yes to covering DV Expo, than NewBay Media came right back and 
asked us to be the official Media Partner for Government Expo - Dec. 2-4 at the Walter E 
Washington Convention Center in Washington, DC.  
Register today! 

GOVERNMENT VIDEO EXPO 
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Government Video Technology Expo reflects the diversity of the government video market, 
including state and local government, law enforcement and federal agencies. And of course 
our men and women in uniform. GV Expo delivers an exhibit hall with more than 200 
vendors, certification and training classes in post-production and a wide reaching 
Government Video conference program covering issues in video, audio, multimedia, 
conferencing and broadcast. 

This is a one-of-a-kind event designed to bring government buyers and sellers together. 
Register today.

We'll be originating two hours of coverage every day at both events. We'll have more on this as we get 
closer. But, if you can free up a day in your calendar, come on over to the 
show and say "Hi!" We'd love to see you.

Click here for DV Expo.

Click here for Government Video Expo.

Click here to learn more about The BuZZ.
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TECHNIQUE: CHANGING AUDIO CAPTURE SETTINGS TO 32 KHZ

Note: In looking over my email for the last couple of months, I've been getting a lot of 
questions about drifting audio sync. if you are capturing a clip and the audio slowly drifts out 
of sync, you need to pay close attention to this article. This is the classic symptom of 
shooting audio at one sample rate and capturing at another.

While most professional cameras record audio at a 48 kHz audio sample rate (also called 16-bit in some 
camera menus), less expensive cameras tend to record audio at a 32 kHz sample rate (which is 
sometimes called 12-bit audio, just to keep us all confused).

While 32k sample rates are perfectly adequate for recording human speech, it tends to be insufficient to 
adequately record music. More importantly, Final Cut defaults to capturing all audio at 48 kHz. When the 
audio isn't captured at the same rate at which it was shot, the audio slowly drifts out of sync.

To fix this, you need to change your audio capture settings before you capture any clips. Here's how.

1. First, determine what sample rate your camera records audio. This is generally done by 
checking the audio setting in your camera menu. If it says 48 kHz or 16-bit, you don't need 
to do anything. Feel free to jump to the next article.

2. If it is set to 32 kHz, or 12-bit, you need to do two things: change the camera settings so 
it records all future audio at 48 kHz, then, create a new setting in Final Cut so that it will 
properly capture any material that you've already shot.  
 
It is generally considered best practice to shoot all your audio at the same settings and 48 
kHz is considered a professional audio sample rate.

3. To create a new capture setting, open Final Cut Pro and go to Final Cut Pro > Audio / 
Video Settings.
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4. Click the Capture Presets tab.

5. Select the video format that matches what you are shooting in your camera. In this case, 
I'm using DV NTSC 48 kHz.The lock at the right side indicates this is an Apple preset that 
can not be deleted or modified. Click the Duplicate button at the bottom to make a copy of 
this preset.



6. In the Capture Preset Editor dialog box, give the new capture preset a name, for instance 
"DV NTSC 32 kHz," then look to the lower right and change the audio Format menu from 48 
kHz to 32 kHz.

7. Click OK to create the new preset. Put a check mark next to it in the Capture Presets 
tab, then click OK again.

You are now ready to capture your 32 kHz audio. 

Remember to go back to the Audio / Video settings menu and change your capture preset when you need 
to capture audio at 48 kHz. 

UPDATE - Oct. 11 

Sabrina Nelson adds:

Capturing 32khz 12bit audio is the bane of my existence... until now, I'd refused to work on 
any project that was recorded in that way. I've spent days redubbing tapes to DVNTSC48k 
for one naughty client, and suddenly I see your timely tip and is like, "Wow, I coulda had a 
V8!". Thank you for the tip on creating a new preset. Its so simple, I should have thought of 
it :P

Larry replies: Thanks.
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LARRY HAS A BLOG!

We began this at the end of August - my very own blog. Since then, I've 
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discovered this is a great way to quickly comment on our industry, or discuss 
new changes in technology 

If you haven't had a chance to visit, take a look www.larryjordan.biz/blog. I try 
to update it several times a week.

Also, feel free to add a comment or two - I always like to hear from you.
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TECHNIQUE: REDUCING NOISE IN SOUNDTRACK PRO 2

One of the exciting features in Soundtrack Pro is its ability to reduce background noise. 

Notice that I said "reduce," not eliminate. If you need to remove a sound, you'll need to re-record the 
audio. If, on the other hand, you just want greater separation between your speaker and the background, 
this tool can do the trick.

Here's the basic problem we have with noise reduction: the normal human ear hears frequencies between 
20 cycles per second and 20,000 cycles per second. 20 cycles is so low it feels more like a vibration, 
while 20,000 cycles is so high, it sounds more like the wind in pine trees. Every voice, sound, piece of 
music, or noise falls within that range of cycles. This means that many noises overlap voice frequencies. If 
we remove all of the noise frequencies, we also remove parts of the voice frequencies, creating very 
strange, and generally unpleasant, effects.

So, our goal is to isolate as much of the noise as we can and remove it without doing major damage to the 
voice. While all noise is different, and no two clips will have the same values, the process of reducing 
noise is the same.

Here's the process.

1. If your clip is already edited into the Timeline in Final Cut, select it and choose File > 
Send to > Soundtrack Pro Audio File Project.

http://www.larryjordan.biz/blog
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2. In the Send dialog, give the file a name and store it in your Final Cut Projects folder. This 
will become a permanent part of your project and will be needed for final output. The rest of 
the defaults are fine. Click OK.

Note: You can repair audio either as an audio file project or by selecting a 
clip in a multitrack mix and choosing the File Editor tab in the Lower Pane. 
Regardless of which you choose, the noise reduction process is the same. In 
this example, to make the screens easier to read, I'm using an Audio File 
project.

3. After listening to the clip, drag across the waveform to select a portion of the clip that 
only contains the noise you want to remove; it should not contain any of the sounds you 
want to keep. Select Process > Noise Reduction > Set Noise Print. This samples the 
noise and stores it into a special clipboard within Soundtrack Pro.

4. Next, select the portion of the clip that you want to remove the noise from. Selection can 
be done by dragging, or double-clicking to select between markers, or pressing Command
+A to select the entire clip.



5. Choose Process > Noise Reduction > Reduce Noise. This opens the Noise Reduction 
HUD (heads-up display) that allows you to fine tune your settings to remove the noise. This 
dialog works from the top to the bottom. Press the right-pointing arrow to start playback. 

6. Slowly drag the top slider to the right and listen carefully until the noise is gone. Here the 
noise was gone when we reached -29.6 dB. At the same time, you'll notice that the voice of 
the speaker starts to sound hollow, electronic, or "Darth-Vader-y". Not to panic. 



7. To get the speaker's voice to sound normal, move down to the second line and drag the 
slider to the left. You'll hear two things: first, the speaker's voice starts to sound human 
again and, second, some of the noise returns. This is generally unavoidable -- that's why 
we call it noise reduction, not noise removal. Stop when the voice sounds "normal" to you. 
In this case, we stopped at 76%. This means that we have removed 76% of the original 
noise. Press the right-pointing arrow to stop playback.

8. If you want a voice to sound warm, inviting, and sexy, you boost the bass. If you want a 
voice to sound clear and intelligible, you boost the treble. That's because vowels are low 
frequency sounds and provide the voice its character. Consonants, on the other hand, are 
high-frequency sounds and provide the voice its diction and clarity. In our case, we want to 
make sure people understand what is being said, so I'll preserve some of the treble.

9. Click OK and watch as the waveform shrinks as the noise is removed. Play the noise-
reduced section and congratulate yourself on salvaging this audio.

10. To get it back into Final Cut simply choose File > Save. If you are doing this in a 
multitrack project, the changes are saved with the clip and will output during your final 
export.

That's it. Once you understand the process, cleaning up your audio is both quick and easy. 



Final note: Whenever you remove noise, you are also removing voice frequencies. This 
means the speaker won't sound as good as the original clip. Sometimes the quality change 
is not noticeable, other times it is. In each case, you need to decide whether the 
improvement in intelligibility outweighs the loss in quality. If you remove noise carefully, 
you'll find that in most cases, the answer is yes.
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NEW TRAINING VIDEO --  
CHROMA-KEYING IN FINAL CUT STUDIO

Last month, I announced a new title showing how to do Moves on Stills. This 
month, we have a new title on how to chroma-key inside Final Cut Studio.

This title has an unusual format in that it starts with me on camera walking 
around a green-screen set, describing how to set and light for a key. Then, I 
move to Final Cut Pro to see how to use the keyer in Final Cut. 

As many people have discovered, the keyer in Final Cut Pro can not be called 
state-of-the-art. In fact, it generally, um, sucks. So, I also show you how to use 
the keyer in Motion, which is much better. 

But, not always good enough. Which is why this title also includes tutorials on three other keying software: 
Oak Tree Software's vKey2, dvGarage dvMatte Blast and dvMatte Pro, and Red Giant Software's 
Primate Keyer Pro 4. 

Then, I spend a lot of time showing how to solve keying problems like uneven lighting, wrinkled 
background, and cast shadows.

If you've ever needed to remove a background and had problems doing so, you need to add this training 
to your library.

Click here to order.
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LARRY IS NOW ON MYSPACE

For all you MySpace fans, we now have our own page: www.myspace.
com/larryjordanbiz.

Kristi Prost, our marketing director, maintains the page. And I find it 
fascinating to watch all the links and contacts develop. As a 
complement to our website, the MySpace page keeps you up-to-date 
with all of the exciting things we have going on, as well, it will 
periodically have video features, offer special discounts to our 
subscribers, and allow you to further network with editors and 
filmmakers around the world.

If you haven't visited for a while, stop by and check us out. Spread the word about the page, and if you 
have one of your own, add us to your friend list!
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RECONCILING VIDEO FRAME RATES

Nate Adams sent in the following:

I read your article on reconciling frame rates. I, too, have experienced this recently on a 
project that was receiving graphics rendered out of After Effects at 1080/23.98 (not 23.976) 
8-bit and dropped into an FCP timeline. Now I want to kick myself for not trying to render 
things out of After Effects at 23.976. As long as the FCP render engine didn't touch the 
footage it was OK, but as soon as something was rendered in FCP it stuttered. 

We went through it frame by frame and noticed that frames were actually getting left out 
and others doubled, and with no specific cadence. STILL FRAME>REPEATED STILL 
FRAME>MOVING FRAME>STILL FRAME>...and so on. Unfortunately we were renting two 
bays at the time including a 2k Da Vinci theater for bazillions of dollars a second, so we 
didn't really have time to fuss around. We ended up buying and using Automatic Duck to 
bring the sequence out of FCP without any effects, into After Effects. There we'd add the 
dissolve or motion effect, render out of AE, and drop it back into FCP. Strangely enough, 
FCP was the only application that couldn't interpret 23.98 material properly as 23.976. 
Scratch, Motion, After Effects, were all fine.

Larry replies: Thanks, Nate, for sending this in.
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QUICK TIP #1: REPLACING IMAGES

Rick G. sent in the following:

I just saw your lesson on how to resize photos for FCP, and realized that I made something 
using all JPEG's. So I went and brought all of those photos to Photoshop (CS2) and resized 
them, saving them as png's. When the dialogue box appeared, I left them non-interlaced 
before saving....

Then I imported all the photos back into the browser in FCP. I tried replacing one of the 
photos into the timeline, and it worked fine, except that the attributes (fades, filters, etc.) did 
not remain. So I Command-z'd back to keep the timeline intact.

Is there a way to replace a clip with all the attributes?

Larry replies: Sure, here's how:

1) Load the new image into the Viewer 
2) Choose Edit > Copy 
3) Select the image you want to replace 
4) Choose Edit > Paste Attributes 
5) UNCHECK all options, except Replace Content 
6) Click OK

This will replace the content of the clip in the timeline, without changing any of the attributes.
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QUICK TIP #2: IMPORTING FILES

Jussi Buckbee, from Finland, writes:

Here's a quick tip to import files faster into FCP's Browser. Control-click (or right-click) on 
the Bin you want to import files into. Select whether you want to import files or a folder. 
Then select your files.

Very fast and very nifty. And right into the bin.

Larry replies: Thanks, Jussi. Great tip!

[ Go to Top. ] 

QUICK TIP #3: CAMERA REFERENCE CHART

Scott Carrey sent this in:

You might already know this, but I found this a very handy way to compare cameras: http://
www.fletch.com/images/Video_Camera_Comparson_Chart.pdf

Larry replies: Scott, thanks!
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QUICK TIP #4: PREVENTING VIRTUAL CLUSTER CRASHES

Joe Reeser writes:

A quick thought on your article "Making Compressor Multiprocessor Aware." I've read 
several tutorials on creating a virtual cluster, but while trying would have consistent 
Compressor and FCP crashes when "Virtual Cluster" was selected. I stumbled upon a 
thread in the Apple forums about a similar issue and the user suggested disabling the 
MobileMe (formerly .Mac) feature Back to My Mac. I followed the suggestion and presto! 
Compressor and FCP now work flawlessly using a virtual cluster.

Larry replies: Thanks, Joe, for sending this in.
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CREATING HIGH-QUALITY STILLS FOR HD AND SD

David Scott has been working to create a high-quality HD projected image and an equally high-quality SD 
sequence to go onto a DVD. After many, many, (uh, MANY) emails he has finally developed a workflow 
that he's given me permission to share.

How to Build an FCP Show of Animated Stills and Video for High Definition Projection and Standard 
Definition DVDs (for optimum projected and DVD sharpness and quality)

http://www.fletch.com/images/Video_Camera_Comparson_Chart.pdf
http://www.fletch.com/images/Video_Camera_Comparson_Chart.pdf
http://www.larryjordan.biz/articles/lj_compressor_multi-processor.html


FOR PROJECTION (at 720p)

1. Prepare stills in Photoshop at 3200 x 1800 x 72 (for 16:9 zooming) as TIFs

2. In FCP, set "Sequence" as:

Frame Size - HDTV 720p (1280x720) (16:9) 
Pixel Aspect Ratio - Square 
Field Dominance - Off 
Compressor - H.264

3. Build show, animate, add transitions, etc.

4. Export from FCP:

as QuickTime self-contained movie "at Current Settings"

- OR - 

"Using Compressor" (for even better quality) 
Go to "Settings" 
Go to "Custom" 
Select "16-9 QuickTime H.264" 
Under "Destination" tab, select" to desktop" 
In "Inspector", set Frame Size to 1280x720 
Pixel Aspect Ratio to Square

5. Project using an HD-compatible like the Optoma 739 or similar

FOR SD DVDs

6. From your FCP show, Export "Using Compressor" 
7. Choose "Change Settings" (by control-clicking on file) 
8. Under "Apple", "Other Workflows", "Advanced Format Conversions", "Standard 
Definition", Select NTSC-DV. click "Add" 
9. In Geometry window, go to "Crop to" and select "4x3 1:33.1" which will crop image from 
left and right but preserve the middle 
10. Submit 
11. Import the resulting .mov file into DVD Studio Pro 
12. Delete "Menu" 
13. Set "track" in Menu and End point 
14. Burn DVD master 
15. From DVD master, copy TS files to hard drive 
16. Use TS files in Primera Bravo SE with art to produce DVDs.

NOTES

- Close inspection suggests exports "Using Compressor" (as outlined above) produce better 
enlargements than those done straight to QuickTime at Current Settings (at least, to my 
eyes)

- Likewise, DVDs created using the "Using Compressor" file seem better than those from 
the straight-to-QuickTime export (again, to my eyes)
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READER MAIL

SHAKING IN OUR BOOTS

Dan DiPaola (and many others) wrote:

Larry, after last month's article on losing data from a stored hard disk, you have us shaking 
in our boots here at HD-Encoding. I am sitting on over 100 TB of data from over the last 2.5 
years of doing Disney's Blu-ray trailers. All on 750 GB external drives. Each one of these 
drives is stored in a vault that is sealed and de-humidified. I am getting ready to purchase a 
robotic tape system. Until then I need to know:

1. Approximately how long (mins.) should we expect it take to surface scan each 750GB 
drive? (I am running 750GB SATA drives into my 1394 800 FireWire port.)

2. Is one software package faster than the other?

3. What is the name of the function (surface scan or ?) that will guarantee that my data is 
good for the next 6 months?

4. Do you truly feel that tape (AIT drives) will eliminate this problem? If so for how long?

Larry replies: Dan, I don't have all the answers and can use some help from other readers.

I have been told you can restore data on a hard disk simply by asking it to read all the files on the hard 
disk. This can be done easily, I've been told, using a terminal command, where the hard disk is asked to 
read all files, but do nothing with the data. Since all hard disks are programmed to automatically replenish 
any data that is starting to fade during the reading process, this will solve any potential data loss errors. 

The problem is, I don't know terminal and don't know the command(s) to use. If someone could suggest 
something, I'll share it.

The process of reading all the files on a hard drive should be MUCH faster than a surface scan, which can 
take forever; or at least a very, very long time. 

Simply reading all the files on your hard drive every six months to a year should keep your data safe, from 
what I have been told.

And, yes, I believe that LTO-3 tape is the best archiving system we have at the moment.

Note: Not everyone has lost data from stored hard drives, but I received dozens of emails 
from people who have. This potential data loss is a significant problem, but not a time-to-
jump-off-high-buildings problem.

As I learn more I'll pass it along in my blog and in future newsletters.
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ADDITIONAL PROTECTION

Shari Dyer sent in this tip:

A friend turned me on to this trick - get two pocket drives and back up your important files. 
Keep one in your safe deposit box, and switch the drives on a regular basis, upgrading the 
one at home. I think that's a great idea.

http://www.larryjordan.biz/articles/lj_hard_disk_warning.html
http://www.larryjordan.biz/blog


Larry replies: Shari, this is another good idea.
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AUDIO SOUND DRIFT

Mike Hibberd writes:

I'm a new editor and am using FCP 6 on a new Mac Book Pro 2.5 GHz using OS X 10.5.4. 
I've been struggling with the last few projects with importing a 
second sound track.

Here is what I am using: I shot with a JVC Everio onto an internal hard drive. I convert the 
MOV file with MPEG Streamclip to a DV file and import into FCP.

Although I have shot the video with a Rode Video Directional Mic to improve sound quality, 
I also have a sound track recorded through a sound desk onto a CD. This is recorded as an 
AIFF and then imported into FCP.

What I would like to do in most cases is to use the AIFF sound file as it is the best quality. I 
thought I might mix the two tracks (Video sound and the sound from the desk) for the best 
mix.

When I sync the two tracks in FCP they drift out of sync after about 30 seconds. By the time 
one hour goes by, its a good 3-4 seconds out. I have not been able to use the AIFF file and 
had to rely on the video with the sound recorded through the camera.

The video sequence settings in FCP are - DVCPRO50-NTSC Audio Settings - 48 KHz 
Depth, 16-bit, Config: Channel Grouped.

Larry replies: Mike, my first guess is that the audio sample rate of the JVC is either drifting or not set to 48 
kHz. Final Cut, by default, expects 48k audio during capture. However, you probably shot this at 32k (12-
bit) sample rate on the camera, which will cause the slow drift in audio sync.

The sample rates must match or audio will drift out of sync. Check your camera settings to determine the 
sample rate you shot at, then match it using Audio/Video settings in Final Cut Pro. (See my article earlier 
in this newsletter.)

Also, take a look at your camera settings. If necessary, change them to be sure you are recording audio at 
48 kHz for all future shoots.

[ Go to Top. ] 

RESETTING COMPRESSOR

Dave Duquemin, from Southlake, Texas, writes:

What is up with Compressor? I have the Studio 2 suite and have been using different parts 
since last year. I remember that Compressor did not work very well out of the box. I finally 
went over to Sorenson's Squeeze. I found it very capable. However I no longer work at that 
location with that software. So I am back to Compressor 3.



I start it up and there are no windows showing. I then am able to open the history, preview 
and destinations windows and no others. It makes it kind of hard to work without the main 
interface.

Has Apple heard of this? Will simple "updates" solve the issue? 

Larry replies: It isn't as bad as all that. I use Compressor all the time quite successfully. 

Also, Compressor remembers your last window settings. Go to Window > Layouts > Standard 1440 x 
900 and your windows should all reset.
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SURROUND SOUND MONITORING

Rick Llewellyn sent this in:

On your newsletter about using Soundtrack, and to specifically answer the question of 
surround sound monitoring, the Griffin FireWave is really all you need. It was originally 
selling for about $60, but now it is being discontinued and is available for $20. 

If you don't need sound input or hardware mixing and all you want is to output 5.1 surround, 
this is all you need. I am currently using it with both FCP and Soundtrack on a Macbook Pro 
running OS 10.5.4.

Larry replies: Thanks. Personally, I'm using a Presonus FireBox. It's nice to know there are other 
inexpensive options out there.
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WORKING WITH AUDIO TRACKS

Marcia Orland writes:

I have a question about audio tracks, and get conflicting answers at Apple Store, and from 
other sources: When recording interviews, we use 2 mics, then pick the best track. I dump 
one track, and copy the better one to the 2nd track so I have L & R of the best audio track. 
Then I set the stereo to 0 to balance them.

Recently I hired another editor to start work on a project. At the end of the day, I noticed he 
had only one track of audio, using the best track. He tells me it doesn't make any difference 
as long as stereo is balanced to 0. However it seems to me the sound is richer when the 
good track is copied to the 2nd track. What do you say?

Larry replies: I say your editor is right. What you hear is not richer, just louder. All you are doing is 
duplicating the audio, which increases its volume and runs the risk of the two tracks getting out of sync. I 
recommend against doubling audio tracks unless all other options to increase volume have been 
exhausted.
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MOVING BETWEEN FCP AND AVID

Don Duchene writes:

I am under constant pressure from a colleague of mine to switch to AVID from FCP. We 
often work together and it is awkward having the two different systems. I did at one point 
invest in Automatic Duck and while this helped, really it was not a solution unless things 
were kept very simple. We are about to start a project and we will once again be duking it 
out. You are partly to blame. Your instruction in Lynda.com has been so good that I am 
getting great results on FCP and I hate to start all over again.

Is there a way AVID and FCP can work together? I like to rough things out (as a producer/
director) and then turn a project over to an editor when it has a shape that I like. I thought 
we could just use an EDL to talk to each other but on a little project that I just finished on 
FCP I got a message that said that it could not output a good EDL because of something-or-
other but it did not make it clear what I had to change.

Is it time to give up the battle?

Larry replies: Automatic Duck is your best choice. It is reliable, fast, and very easy to use. 

The problems with EDL is that they only support two video and four audio tracks -- and very limited 
effects. 

However, when using any transfer program, any effects that you create in FCP won't move to the Avid 
unless both have the same effect. For this reason, you want to make the move before you get too far 
down the road polishing your project with effects. 

UPDATE - Oct. 11 

Björn Adamski adds:

Please be aware that the only video input format that can be edited by Avid natively without 
any conversion is Panasonic P2. Using P2 media within an Avid media bin and MXF4mac's 
"MXF4QT Import" to import the same media files in FCP allows direct and native parallel 
access to the same footage. Shared media on a shared storage between Avid and FCP is 
currently only possible with P2.

Larry replies: Thanks - I totally forgot that video files don't move between the two platforms. 
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PICKING THE RIGHT VIDEO FORMAT

Bob Campbell writes:

I have a large number of Hi-8 tapes to capture. I am using a AJA LHe card in a MAC PRO 
quad core machine with internal hard drives. and want to archive/edit this material. I just 
read your news letter about hard drives and still think this is my lowest cost option for now.

Any way, I have searched your archive and have not found anything current. I have heard 
you say in your video's not to use for SD video, but I would like to maintain 422. Is DV 50 
the next best thing? The AJA card will only let me select ProRes HQ, not ProRes which 
maybe overkill for the Hi8 playback from my camera. What would you suggest is the best 
approach?

http://www.automaticduck.com/


Larry replies: ProRes is a good choice, but ProRes HQ is overkill. It will work, but your file sizes are really 
big. DVCPRO-50 will provide smaller file sizes with excellent quality. Try DVCPRO-50 first and see if you 
like it. If not, you have ProRes as a backup.

Using ProRes for SD material is fine, its just that you won't see much saving in quality, speed or file size. 
ProRes and Uncompressed 10-bit NTSC are both about the same file size and both are 10-bit. So ProRes 
is not a significant improvement over what is already there. 

UPDATE - Oct. 11 

Eddie Boyce disagrees:

I believe your reply to Bob Campbell warrants more thought. It sent me on a search to re-
read the Apple white paper on ProRes. The entire point of the codec is that it is meant to be 
a finishing codec at a fraction of the file size. The HD data rates are actually lower than 
standard def uncompressed 10-bit. It's target data rate for a ProRes HQ 720x486 frame at 
29.97 is 63Mb/s or 7.9MB/s. That's just a touch more than double the rate of DV.

Whereas uncompressed 10bit is a whopping 25.3 MB/s or roughly 3.2 times as large per 
frame. Patrick Inhofer has done tests that show that ProRes is a finishing codec up to the 
harshest standards and is clearly head and shoulders above DVCPRO 50 (a much more 
lossy format) at nearly the same data rate. The ProRes basic data rate is 5.25 MB/s, this is 
actually less than DVCPRO 50 which is 6.8 MB/s and ProRes is far far superior in terms of 
it's generational loss.

Basically, someone working in standard def would be foolish not to use the additional 
quality (shown to be visually lossless) of ProRes HQ when it clocks in at a less than a third 
of the data rate of uncompressed 10-bit and just about the same data rate as DVCPRO 50.

The Apple white paper: 
http://images.apple.com/finalcutstudio/resources/ 
white_papers/L342568A_ProRes_WP.pdf

Patrick Inhofer's tests: 
http://www.fini.tv/blog/finishing_line_files/proresSD%20test%20results.php

One River Media's codec library: http://www.onerivermedia.com/codecs/

Please let me know if you find my information to be erroneous.

Larry replies: Eddie, thanks for writing. Because ProRes uses a variable bit rate encoding system, actual 
file sizes will vary depending upon the complexity of the file. My numbers differ from yours, so I'm glad to 
share these links so editors can make a more informed decision. 
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MORE CONFUSION BETWEEN HDV AND AVCHD

Thomas Farris writes:

I'm a one man production team climbing the newbie learning curve of HD Formats, Final 
Cut Studio 2, Compressor, and output. 

One thing puzzling me is the that 1080i and 1080p can be 1920x1080 or 1440x1080. I 
know it has something to do with perception or perceived pixels or non-square pixels but it 
gets confusing when I'm trying to down-sample and compress because often I think I'm 

http://images.apple.com/finalcutstudio/resources/white_papers/L342568A_ProRes_WP.pdf
http://images.apple.com/finalcutstudio/resources/white_papers/L342568A_ProRes_WP.pdf
http://www.fini.tv/blog/finishing_line_files/proresSD%20test%20results.php
http://www.onerivermedia.com/codecs/


working with 1920x1080 but bring it into compressor and it's reading as 1440x1080 all 
along trying to get it to 960x540. Would 1440x1080 down-sample to 720x540. 

I apologize for the rambling. It's hard to even put this problem into clear sentences.

Larry replies: Thomas, the easiest way to handle this is to ignore the actual pixel counts of your video. 
Assume, even though it isn't, that all your HD footage is either 1920 x 1080 (for 1080 video) or 1280 x 720 
(for 720 video). Use those dimensions, or variations of them, in your compression and things will look 
great.

So, scaled down 16:9 sizes that would work for the web include:

960 x 540 
800 x 450 
640 x 360 
480 x 270 
320 x 180
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CAPTURING AN ENTIRE HDV TAPE

Jagadish, from Bangalore, India, writes:

I am Jagadish, working for a regional channel in India as editor. i am capturing HDV tape 
1080i50. while capture time each scene is capturing separately. i have disabled scene 
detect option, even though it's capturing scene-wise. i am using FCP 6.0.4. i want to 
capture 1-hr continuously.

Larry replies: Capturing an entire tape containing multiple shots is not possible with HDV - unless you 
bypass FireWire and capture using the analog output of the camera with a capture card, such as AJA or 
Blackmagic Design.
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RECORDING DV TO AN HVX-2OO

John Hogarty writes:

I do some volunteer work for my kids school and they need me to provide the final output 
on DV tapes. I've been having a heck of a time with this while trying to use Print to Tape in 
Final Cut Pro 6.0.4 and my Panasonic HVX200. The last time I got it to work by exporting 
my project (several video and audio layers,) to a file, then create a new sequence and drop 
that file on it.

But this time around, following what I thought was the same steps, all I'm getting out to the 
camera is Audio. The video will preview on my Mac running FCP, but the camera LCD just 
shows a black screen. On playback thru the camera, all I get is audio. Is there a solid way 
to setup FCP with my HVX so I don't spend hours trying to get both video and audio out?

Larry replies: This sounds to me like your camera is expecting an HD signal, when you are sending it an 
SD one. Hearing audio with no video generally means the video input of the camera is set incorrectly. 
Double-check your camera menu settings and make sure the input is set to DV or SD. 
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PICKING A BETTER WAY TO EXPORT

Mike Andrade writes:

A quick question on how to get as much quality out of DVD SP as possible. It always 
seems my burns look horrible when I play the disc back on my 24" iMac or any consumer 
DVD player. Everything gets stretched and Jaggy. I usually export an animation QT out of 
Motion at 854x480 and bring it in to DVD SP because if I try using the actual .motn file it will 
take 2 days to burn. Should I be creating larger files than the 854 to compensate for the 
stretching. Thanks in advance for any help you can provide. 

Larry replies: Mike, this export method won't work. Use File > Export > QuickTime movie. Set Output to 
Current Settings (the default) and make it a self-contained QuickTime movie. Don't worry about pixel 
counts. Don't judge how it looks in the QuickTime movie.

Bring the file into Compressor and compress your MPEG-2 file. Proportions and quality will all look great.
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EXPORTING VIDEO TO MXF FORMAT

Juan Eduardo Capril writes:

How can i export from FCP6 to a MXF format??, the media is recording in a PMW-EX1 
camcorder Sony XDCAM EX 1920x1080

Chris Kollmar sent me the answer: 

If you have the XDCAM transfer plugin installed you can do an export of a sequence or 
selected clip in the browser to MXF format.

First, set your audio outputs to dual mono instead of Stereo.

Make sure your sequence or clip is selected in the browser. Then, go to File > Export > 
Sony XDCAM. A dialog box will pop up asking where you want to put the files.

I have a PMW-EX1 and just did a test - it works.

Björn Adamski adds:

The Sony XDCAM Transfer tool also offers an export plug-in to use with FCP. 
There were issue reports with sequences longer than 20 minutes but maybe 
this has been fixed with recent updates.

Here's where you can find them: http://www.sony.ca/xdcamex/software.htm
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ITS THE LITTLE THINGS THAT COUNT

Karen writes:

I have Final Cut Studio, and have no idea how to find Motion or any of the other add ons, or 
if I need separate software for them. Are the cool things there? If so, how do I get to them. 
The interconnection between the who STUDIO thing is a step I'm missing.

Larry replies: There are seven applications within Final Cut Studio. You don't access these applications 
from within Final Cut Studio. Instead, each is a separate icon in your Applications folder - just double-click 
the icon to run the application:

Final Cut Pro 
Soundtrack Pro 
Motion 
Compressor 
DVD Studio Pro 
LiveType 
Color
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SAVING PREFERENCE FILES

Brian Seegmiller writes:

Larry I am watching your Lynda training on FCP and you mention if you have favorite 
motion or effects saved they will be gone when you reset your preference files. Can you 
make a copy of them,save them somewhere else and then replace them when needed? Or 
do all of the preference files get corrupt including favorites?

Larry replies: The best way to do this is to use FCP Rescue 6. Its free and makes a backup of your 
preference files. 

You can find a copy here: http://fcprescue.andersholck.com/

The best way to use this is to trash your preference files, reset everything exactly the way you want, QUIT 
Final Cut Pro (which writes your preference files to the disk), then run FCP Rescue.
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MODIFYING AUDIO LEVELS

Marcia Orland writes:

Once an audio track has been cut on the timeline, is there a way to globally change the 
audio level, other than adjusting each section individually?

Larry replies: Aside from selecting the clips you want to change and choosing Modify > Levels, no.
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WORKING WITH POWERPOINT SLIDES IN VIDEO

Mair Musafija writes:

I appreciate your expertise and considering you important part of the Final Cut Pro world. I 
have question related to incorporating graphics in the video. I have project where I am 
combining Power Point Presentation with DV video. The way I exported PPT in mov file and 
I am cutting it into the video file. The PPt slides deteriorated tremendously when included 
on the time line. Is there any way to compensate for the loss of quality? Maybe you can 
give me a reference pointing toward right answer.

Larry replies: The key is to create and design your PowerPoint slides to match, as closely as possible, the 
image size of video. For example, with SD, create them at 800 x 600.

There will still be a loss in quality, because video is lower in resolution than your computer, but this will 
minimize it.
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PROBLEMS FORMATTING A DVD

Steve writes:

Hi Larry, I am having a problem formatting a DVD in DVD Studio Pro, it says in the log that 
"language codes for english and english-2 must differ".

What do you think the problem is?

Larry replies: Look in the Outline tab and you'll see two EN language tags assigned to the same thing. 
Remove one of them and things should work OK.
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WHY DOES DV LOOK BAD?

Cliff Galbraith writes:

I created some animation in Flash, composited it in After Effects as an NTSC D1 Square 
Pixel 720 x 540 composition and exported it as a QuickTime, high quality, 720 x 486 -- 
which, when viewed as a QuickTime file, looks pristine.

Then, when I output the video to QuickTime, it looks poor -- isn't that an indicator that 
something's wrong?

Larry replies: No. 

DV video requires a hardware chip to decode IN REAL TIME. When you compress this file for posting to 
the web, your video is properly decoded -- but it takes longer than real-time to do so.

Since both FCP and QuickTime are designed for real-time playback, the quality of the video is somewhat 
lessened. When it is compressed, monitored via a DV device, or recorded to tape, the resulting quality is 
excellent.



In short, this decrease in quality is an artifact of wanting to play the SOURCE file in real time, and does 
not show up when compressed for the web.
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WRAP-UP

Well, that's about it for this month. 

For current news on what's happening in our industry, be sure to listen to the Digital Production BuZZ 
podcast every week.

�●     Register now for our PowerUP seminar tour - our tour will be much smaller next year. 
�●     Visit our store for our latest training videos - like Chroma-keying in FCP & Motion. 

In the meantime, please continue sending me your comments and questions. I love hearing from you and 
enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up 
at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not 
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying 
these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has 
not been reviewed or sanctioned by Apple or any other third party. All trademarks are the 
property of their respective owners and are mentioned here for editorial purposes only.

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/sem/2008_fall.html
http://www.larryjordan.biz/app_bin/Store/catalog/
mailto:larry@larryjordan.biz?subject=Newsletter comments
http://www.larryjordan.biz/nxltrs/ljnxltr49.pdf
http://www.larryjordan.biz/nxlttrs.html


Text copyright 2008 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter 
may not be reproduced or published in any way, in whole or in part, without specific written 
permission from the author. 

Links to my home page or website articles are welcome and don't require prior permission. 

            
        

Home | About | Training | Articles | Goodies | Products | Email Support | Contact

© 2008, Larry Jordan & Associates, Inc. All rights reserved. info@larryjordan.biz

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/about/index.html
http://www.larryjordan.biz/training/index.html
http://www.larryjordan.biz/articles/index.html
http://www.larryjordan.biz/goodies/index.html
http://www.larryjordan.biz/store/index.html
https://www.larryjordan.biz/supportemail.html
http://www.larryjordan.biz/contact/index.html
mailto:info@larryjordan.biz

	larryjordan.biz
	Larry's Monthly Newsletter - #49 - Oct. 2008


	LJADABAPCNDPPGFLHCKIFGFKPAFDGJKC: 
	form1: 
	x: 
	f1: Enter your email
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 

	form2: 
	x: 
	f1: 
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 




